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Change Log

The following table lists all major changes made to this document.  Entries give the date the document was 

updateds, the initals of the person updatng the documents, and a brief descripton of the change.

Correcton of typographical errors and minor or non‐substantve changes to the document are not noted in the 

change log table.

Date Changes Made By Brief Description of Change

09‐JUL‐2015 CPC First Draf
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Overview

Introduction This document provides an overview of the MerLin intranet portal which has been ported 
to Microsof’s SharePoint 2013 platorm.

MerLin has historically existed as a custom‐built intranet portal and was created in 2004 
for the general use by Merchant Link staf members. The inital goal of this system was to 
centralize informaton and to make it more accessible to the general Merchant Link 
community.

Over tme this system has grown to include a number of tools and systems to include a 
Learning Management Systems, a Document Management Systems, several request forms 
and tools as well as a communicatons platorm.

With changing tmes has come increased need for a more scalable and standards‐based 
system that can integrate more richly with the various tools we use on a daily basis. 
Microsof SharePoint has been a early runner in ofering a next‐generaton soluton to our 
growing needs and opens our ability to develop and deploy solutons for our community.

Transitioning
To

SharePoint

Changing to the SharePoint platorm requires that we maintain MerLin’s current 
functonality and features untl beter solutons are deployed to replace those tools and 
features.

Modules built in MerLin such as the Learning Management System (LMS or Passport to 
Learning) are integrated through IFrame‐based pages and other solutons. These tools are 
tailored to adopt the look and feel of the new SharePoint environment but stll access the 
data stores and resources that have been built over the last 11 years. With few 
exceptonss, all tools and features in the customized version of MerLin are available in 
MerLin SharePoint. This guide will provide details on any changes to those tools.
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SharePoint 2013 Overview

What is
SharePoint?

SharePoint is a web applicaton platorm in the Microsof OOce server suite that combines 
various functons which are traditonally separate applicatons:  

 Intranet

 Extranet

 Content Management

 Document Management

 Personal Cloud

 Enterprise Social Networking

 Enterprise Search

 Business Intelligence

 Workfow Management

 Web Content Management

 Enterprise Applicaton Store

Merchant Link, LLC. | SharePoint 2013 Overview 11
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SharePoint
Structure Structural Terms 

These terms refer to the structural components of SharePoint. 

Term Description 

Site 

Collection 

The site collecton is an administratve boundary that groups a number 
of sites into a singles, managed unit. All sites in a site collecton can share
permissionss, navigaton and branding. In additons, all sites in a site 
collecton will begin with the same URLs, which is the URL for both the 
site collecton and the top‐level site. 

Site A site is a primary unit of administraton. It is a container for lists and 
librariess, and provides the basic unit of administraton for collaboraton 
and communicaton. A site is identfed as either a top‐level site or a 
subsites, depending on its relatve positon within the site collecton 
hierarchy. 

Top Level 

Site 

This is the top most site within a site collecton. There can be only one 
top‐level site in each site collecton as the top‐level site shares its URL 
with the site collecton. All other sites in the site collecton are subsites. 

Subsite A subsite is a child site within a site collecton. 

List A list is a container for content and consists of items. Items are also 
known as column data. 

Library A library is a special type of list where each item is a fle with additonal 
column data. 

Page A page is the main unit of presentaton of informaton. A site can use 
diferent customized pages to present informaton to the users. 

Web Part A web part is a placeholder for content on a page. A web part may bring
in data from a number of diferent sourcess, based on how the web part 
is built and confgured. 

Column A column is additonal informaton about a piece of data (i.e. date or 
author) in a list or librarys, also known as a SharePoint feld or metadata. 

Metadata Metadata is additonal informaton or “data about data” beyond the 
default propertes confgured in a list or librarys, also known as a 
SharePoint feld or column. 

Content 

Type 

Content type is a reusable collecton of metadata (columns)s, workfows, 
behavior and other setngs for a category of items or documents in a 
SharePoint list or document library. 

Navigating
SharePoint

There are a number of navigatonal elements in SharePoint you should be familiar with. 

Using these names consistently will help you develop a working vocabulary for support calls 

or other assistance provided. The following screenshot highlights them:  

Figure 1 - SharePoint Window Elements
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Ribbon Tab Description 

1 - Global 
Navigation

Also known as the top link bars, global navigaton extends across the 
top of the window. This element can be made available throughout 
the entre site collectons, thereby providing a consistent experience 
for the user regardless of which subsite they may be working in. 

2 – Site Logo Nestled in the top lef corner between global navigaton and current 
navigatons, the site logo will return a user to the home page of the 
current site when someone clicks on it. 

3 – Current 
Navigation

Also known as the quick launchs, current navigaton extends down the
lef side of the window. The links in current navigaton can be 
customized and are partcular to the current site by default. 

4 – Setngs 
menu / Gear 
Wheel

Located in the top right corner of the windows, the Setngs menu 
provides a way to add apps and pages as well as to customize the 
setngs for the site. 

5 – Site 
Content Link

Available from current navigaton and the Setngs menus, Site 
Contents will display all the apps that are on a site. Although the 
default behavior of an app is to add a link of itself to current 
navigatons, site administrators may choose to de‐cluter current 
navigaton. If sos, all the apps can stll be accessed from the Site 
Contents link. 

Interacting with the Ribbon 
The ribbon is a context‐sensitve control across the top of the pages, which adapts to the 

current actvity of the user. Diferent optons appear in the ribbon for the user depending on 

the current focus in the browser. For examples, when looking at a Calendar lists, the ribbon 

will present two optons:  Event and Calendar. Howevers, when looking at a Librarys, those 

optons will be replaced with Document and Library. The following table outlines some of the

diferent ribbon tabs that users may encounter:  

Ribbon Tab Description 

1 - Browse The Browse tab hides the ribbon tools to reveal the global 
navigaton (i.e. top link bar). 

2 - Page The Page tab provides tools for managing the pages on a site. 

3 – Format 
Text

The Format Text tab is available while editng a page; it provides the 
basic formatng and page layout tools. 

4 - Insert The Insert tab allows objects to be inserted on the page currently 
being edited. 

5 – Web Part The Web Part tab is available when a web part is selected on a page;
it gives access to setngs for the web part. 

Figure 2 - Ribbon – Page Tab
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Figure 3 - Ribbon – Page Editing Tabs

Ribbon Tab Description 

 6 - Files Similar to the Items tabs, the Files tab provides additonal tools for 
interactng with documents. 

7 - Library Similar to the List tabs, the Library tab is used for managing the 
library. 

8 - Items The Items tab provides tools for managing the items on a list. 

9 - List The List tab provides tools for managing the list itself. 

10 - Events Virtually identcal to the Items ribbons, the Events tab refects the 
emphasis on the calendar. 

11 - Calendar Similar to the List tabs, the Calendar tab provides tools for managing
the calendar. 

Figure 4 - Ribbon – Library Tabs

Figure 5 - Ribbon – List Tabs

Figure 6 - Ribbon – Calendar Tabs
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Creating a New Document from SharePoint 
Loading content into SharePoint does require an extra step to upload the fle. An alternatve 

opton is to create new documents within SharePoint. This approach ofers several benefts 

including the automatc associaton of the fle to the document library upon saving and 

associaton of content type columns also known as metadata. 

Every list and library has an associated content type. If multple content types are associated 

with a partcular librarys, a drop‐down menu with multple optons will be available. 

1. Navigate to the desired library. Click Files > New Document > New Document.

2. Edit the document and click File > Save As to save the document back into the 

originatng document library.

Note

SharePoint ofers the ability to defne document templates based on strictly defned 

Content Types. Document templates can then be associated with the defned content 

type. 

For instances, if the Business Development Group has a standard contract templates, that 

template can be defned and placed into SharePoint as a new document type. This 

feature provides the ability to ofer a common startng point and beter uniformity in 

the documentaton produced by the staf.

Editing a Document from SharePoint 
Once fles are stored in SharePoints, any changes made to a fle opened within SharePoint are

saved automatcally to the fle stored in SharePoint. 

1. Navigate to the fle to be edited. 

2. Click the Open Menu icon to open the document propertes window. 

3. Click Open to launch the fle in the natve client applicaton. 

4. Author the changes within Microsof OOce and save the fle to write the changes 

back to SharePoint.

OR 

1. Navigate to the fle to be edited. 

2. Click the fle name to open the document in the natve client applicaton. 

3. Author the changes within Microsof OOce and save the fle to write the changes 

back to SharePoint.

Viewing or Editing Document Properties 
Once fles are stored in SharePoints, the document propertes may need to be added or 
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adjusted. 

1. Navigate to the fle to be edited. 

2. Click the Open Menu icon to open the document propertes window. 

3. Click the next Open Menu icon to expand a secondary menu. 

4. Click Edit Propertes to see additonal informaton about this fle. 

5. Click the Save buton to update and close the document propertes page. 

6. Users select the View Propertes opton from the open menu to view the additonal 

informaton.

Another way to view or edit document propertes is by using the Microsof ribbon. 

1. Navigate to the desired library. 

2. Click the checkmark icon next to the fle name. 

3. Click Files > Edit Propertes to launch the same propertes window for the selected 

fle. 

Users can only view the propertes of one document at a tme.
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SharePoint
Roles

Role Responsibilities and Tasks

Portal / Farm 
Administrator

Responsible for global portal and WSS confguratons, shared servicess, 
policiess, proceduress, and portal vision.

 Confguraton of SharePoint

Site Collection 
Administrator

Site Collecton Administrators (SCA) have a moderate understanding of 
how SharePoint works and largely rely on understanding how Sites, Lists 
and Libraries work and be able to manage the content for users. 

Site Collectons are supported by a SCA and issues are routed to them 
frst. SCAs are the frst in line of supports, user educaton and 
administraton. This role requires the understanding of the core purpose
of the site collecton and where to grow it.

Responsible for site collecton and provisioning of subsites. Responsible 
for administering and maintaining site

 Enforce site standards (layoutss, security processess, etc.)

 Local contact for local employees

 Confguraton of SharePoint

 Site provisioning

 Manage security/permissions for all sub‐sites

Site Owner Site Owners are responsible for one part of a Site Collecton onlys, and 
cannot change anything on Site Collecton level. They have full control 
on one or more subsitess, and cans, create lists and subsitess, and actvate 
certain site‐level features. 

 Primary and secondary site owner.

 Manage the site layouts, structures, and content within the 

collecton guidelines and rules
 Content creaton.

Reader Readers are the most generalized group. They have litle to no editng 
permissions over content and structure of the Site Collecton or 
subsites. They generally have “read‐only” access. In the Site Collectons, 
these users will default to their department‐based permissions.

Site Owners

Department Staff Member – Site Owner Role

Business Development Emanuel Barnes

Enterprise Security Jay Konar

Finance and Accounting

Financial Resolutions

Human Resources / L&D Clark Case

Merchant Link, LLC. | SharePoint 2013 Overview 17

Version 0.0.15.0709



An Overview and User Guide MERLIN ON SHAREPOINT 2013

Department Staff Member – Site Owner Role

Implementation Mesfein Lulseged

Information Technology

Installation Mesfein Lulseged

Marketing Amy Bobitka

Network Operations Mike Franks

Product Group

Sofware Development

Technical Support Don Netleman

QA Testing Members
The following staf members are designated quality assurance testers taking on the role of a 

standards, non‐privileged user. 

Department Staff Member – Reader / Member Role

Business Development

Enterprise Security Misael Henriquez

Finance and Accounting

Financial Resolutions

Human Resources / L&D David Whipp

Implementation Oneka Henry

Information Technology

Installation Ryan Allen

Marketing

Network Operations

Product Group
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Department Staff Member – Reader / Member Role

Sofware Development

Technical Support
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Creating and
Editing Basic

Content

The foundaton of SharePoint is the ability to organizes, store and share all types of content 
including documentss, images and videos. The process of moving that content into SharePoint
2013 varies. This lesson covers moving and creatng new content within SharePoint 2013. 

Adding Content to MerLin on SharePoint 
There are many ways to add content to a SharePoint 2013 document library. Some of the 
most common ways include editng or creatng new site pages or by uploading documents 
and fles from a local computer or network share browser. 

Creating a New Page
Creatng new pages for your department site takes a few basic steps: 

 Navigate to your department site.

 Press the Site Setngs / Gear Wheel buton on the SharePoint bar.

 Select Add a Page from the menu.

 Enter a new page name in the dialog box.

 Press Create to create a new page.

 A new page displays in Edit mode

 When you are done making your editss, select the Page tab and press the Save 

buton.
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Editing a Page 
The home pages, created as part of a Team Sites, is based upon Wiki pages. This gives site 
administrators the ability to customize the home pages for various team sites. Multple 
pages can be created for a sites, and stored in the Site Pages library. This allows for the 
creaton of diferent landing pages for a site. Alsos, if a site or site collecton administrator 
wants to develop a new home pages, the old home page can remain in place untl the new 
one is fnished. 

To edit an existng pages, navigate to the desired page and: 
1. Select the Page tab on the Ribbon
2. Click Edit in the global toolbar. 

3. Notce the ribbon has two additonal tabss, one for text formatng and the other for 
insertng objects onto the page. 

Changing the Layout of the Page 
The default layout consists of a header content placeholder with two columns directly 
below. This layout may work for many sites. Howevers, site owners may determine that this 
layout does not support the amount of content desired on the home page. The Text Layout 
feature creates diferent areas on the page to be flled out. 

1. Navigate to the desired site. 
2. Click the Edit buton in the global toolbar. 
3. Click the Format Text tab. Press the Text Layout buton under the Layout secton. 

4. Select an alternate layout from the drop‐down menu. 
5. Notce the page layout updates to include additonal columns or rows.
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6. Click Format Text > Save from the Edit group.

Hiding the SharePoint Quick Links Navigation Panel
The current template in place for MerLin on SharePoint provides fles and cascading styles 
that can further customize a SharePoint page. In some instancess, your page design may 
require that the Quick Links panel be hidden from view: 

      

To suppress the Quick Links panel on any give pages, perform the following steps: 
 Navigate to the desired page.

 Select the Page tab from the Ribbon. Press the Edit buton. The page enters edit 

mode.

 Place the inserton cursor at the botom of the page under any content or webparts.

 Select the Insert tab from the ribbon and then press the Web Part buton.

 Select Media and Content from the Categories list and then Content Editor from 

the list of Parts.

 Once the web part is in place press the dropdown arrow from the far right and 

select Edit Web Part from the context menu that appears.
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 Under the Content Link secton enter the following URL:  

/Style Library/XSL Style Sheets/ml_hideLefNav.txt. 

Click on the Test Link hyperlink. If the link was correctly typed ins, a text fle will open
in Notepad with some code.

 Expand the Appearance secton and change the Title to something descriptve like 

“DO NOT REMOVE ‐ hideLefnav”. This will label the web part’s ttle to clearly 
identfy it.

 To prevent the ttle and web part from showing on the pages, scroll to the botom of 

the Appearance secton and change the Chrome Type selecton to None.
 Press the OK buton. The Quick Links navigaton panel should now be hidden.

 Select the Page tab from the Ribbon and then press the Save buton to commit the 

changes.

Adding Files to SharePoint
The types of fles that can be stored in SharePoint 2013 includes, but are not limited to:  

 OOce documents 

 Multmedia fless, including imagess, video and audio 

 PDF 

 XML 

Uploading a Document
1. Navigate to the desired document library. Click File on the ribbon.
2. Click on the Upload buton.

3. In the dialog windows, click the Browse buton and select the desired documents, 
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then click OK.

24 Merchant Link, LLC. | SharePoint 2013 Overview

Version 0.0.15.0709



MERLIN ON SHAREPOINT 2013 An Overview and User Guide

Creating
Subsites

SharePoint provides the ability to create subsites with a variety of features. Subsites can be 
team focuseds, workfow driven for a more “published” feel and functons, or centered on a 
project with standard project related tools for task tracking and documentaton control. 
These are but a few of the types that are available.

To create a new Subsite follow these steps: 

1. Click on Site Setngs / Gear Wheel and select Site Contents from the menu the Site
Contents page appears.

2. Click on the New Subsite link under the Subsites secton.
3. Enter values for the Titles, Descriptions, and Web Site Address (URL)s, select a 

Templates, and adjust the Permissions and Navigation Inheritance.
4. Click Create when done. You will be redirected to the Site Contents Page and the 

Subsite will be listed towards the end (under Subsites)

Create a Project Site
SharePoint provides a Project Site template that contains a set of webparts and pages to 
help Project Managers and Team members work on projects more eOciently. With Project 
Sitess, users can capture tasks and assign them to people in their organizatons, store and 
manage project‐related documentatons, track project team events on a common calendars, 
view the project’s status on a tmeline and more.

Each project site has these project functonalites actvated by default. These featured add a 
task list with a visual tmelines, a calendars, and the Project Summary web part to the project 
site. 

To create a new Project Sites, follow these steps: 

1. Click on Site Setngs / Gear Wheel and select Site Contents from the menu the 
2. Click on the New Subsite link under the Subsites secton.
3. Enter values for the Titles, Descriptions, and Web Site Address (URL)s, select the 

Project Site entry under the Template sectons, and adjust the Permissions and 
Navigation Inheritance.

4. Click Create when done. You will be redirected to the Project page

The new project site will contain Project Summary webparts, a Getng Start with your Site 
(or Tiles) webparts, news feed webparts, and a default Task list with a tmeline. These new 
webparts and lists can help teams in tracking and managing projectss, assigning tasks and 
collaboratng with content related to projects in a more productve way.

Team Site VS Project Site

Project Sites
 Project Sites have project functonality and site features actvated by default.

 A Project Summary WebPart is added to the main page by default.

 Project Sites have task lists added by default.

Team Sites
 Team sites have wiki page or home page site feature actvate by default.

 Project functonalites are not actve by default.

 Project webparts are added manually as they are not added by default.

 Team sites have team tasks listed rather than project tasks.
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TimeLine & Project Summary WebParts
TimeLine & Project Summary are new WebParts that are added to each site created using 
Project Site Template.

TimeLine WebPart
Similar to Microsof Project Server the tmeline webpart provides an overview of the tasks 
that are added to a task list on a SharePoint site. Every task list by default displays a tmeline 
webpart. With the tmeline webparts, users have ability to adds, removes, displays, Indents, 
moves, and delete tasks and subtasks. Additonally users can also change the font faces, sizes, 
formats, and color for the text used on the tmeline. A typical task list tmeline is shown in 
Figure below.

The Timeline above displays tasks and subtasks which are added to the corresponding task 
list below. These tasks are frst created in the task list and then added to the tmeline. 

Project Summary WebPart
The project summary webpart provides a tmeline with a high‐level view of the events and 
tasks in a project this webpart is added by default to the project site’s main page.

A typical Project Summary WebPart connected to a tasks list is shown in the fgure below.
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MerLin on SharePoint

Overview MerLin on SharePoint 2013 represents the 5th major version of Merchant Link’s intranet 
portal. Under SharePoints, MerLin should be regarded as an informatonal hub and set of 
basic tools for various departments. MerLin is a specifc identty while SharePoint can refer
to other site collectons and tools that exist outside of MerLin.

Site
Structural
and Style

Rules

This secton discusses the basic layout and style guidelines that must be followed using the
site design created for MerLin on SharePoint.

These rules cover both the look and feel as well as informaton organizaton and site 
scalability. Any deviatons from these standards should be brought to the governance 
board for approval.

Page Banner Graphics

Banner graphics on department home pages are no more than 620px in width. Using 
banners of a larger size will afect the layout of the page.

When insertng a pictures, ensure you turn of the padding by: 
1. Clicking on the image to select it.
2. Click on the Image tab on the Ribbon.
3. Change the Horizontal Space and the Vertical Space setngs to 0px.

4. Save the page.
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Universal Site Structural Elements
Every department site must include the following links in the quick links navigatonal panel
that appears on the lef of the page: 

 Site Home (i.e. Learning and Development Home)

 Documentaton

 Etc………
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Adding News
and Event

Items

MerLin on SharePoint contnues the traditon of providing a means to post 
announcements on news items of interest as well as events that are coming up. The 
homepage for MerLin contains a custom What’s New web part that aggregates news 
items from all subsites in the site collecton: 

News items created at the root level or on any department subsite will appear here. This 
secton will show the last 5 posted news items.

Creating a News Entry
 From your department homepages, press the Site Setngs / Gear buton.

 Select Site Contents from the drop down menu.

 Select the [Department] New list. (Wherein Department is replaced by your 

department name or abbreviaton.)

 The department News List displays.
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 Select the List tab from the ribbon.

 Press the New Item buton.

 Enter a Title for the news item.

 Enter a Summary for the news item

Note
The Summary feld is what displays on MerLin’s homepage. This fled should be 
brief and images should be small. (no more than 120px. X 120px.) 

You can use the Image tab to properly wrap text around an image by pressing the
Position buton and selectng Lef while the image is selected.

 Enter the Body of the announcement. This will show on the announcement detail

page. The summary will not show on that page.

Note
If you use images or table formatng to control the layouts, you must not create 
content with a width greater than 900 pixels in width or the content will fow 
outside of the template content area.

 You can enter a desired Expire Date but that data is not being used to control the

display of the announcements at this tme.

Creating an Event Item

30 Merchant Link, LLC. | SharePoint 2013 Overview

Version 0.0.15.0709



MERLIN ON SHAREPOINT 2013 An Overview and User Guide

Calendar Events are currently being maintained by the Site Collecton Administrator. 
Contact the SCA for assistance.
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NOC
Homepage
Accordion

List

The NOC contains a list of categorized links in a collapsible accordion list. Link categories 
are managed through a standard SharePoint list. Links are displayed using a customized 
Content Query Web Part.

Adding a Category
 From the NOC Homepages, press the Site Setngs / Gear buton.

 Select Site Contents from the drop down menu.

 Select the NOCAccordion list.

 Click on the List tab on the Ribbon.

 Click on the List Setngs buton.

 Select the Category feld under the Columns secton.
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 Scroll to the botom of the list of available optons. Enter a new line in in the 

order desired under the secton enttled Additional Column Setngss

 Scroll to the botom and press Save.

Adding a Link
 From the NOC Homepages, press the Site Setngs / Gear buton.

 Select Site Contents from the drop down menu.
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 Select the NOCAccordion list.

 Select the Items tab from the Ribbon.

 Press the New Item buton.
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 Enter the Title of the link.

 Enter the full URL for the link. Optonally enter a descripton for the link.

 Select the link Category.

 Select how the link will open under the URL_Target.

 Press the Save buton.

Updating a Link

 From the NOC Homepages, press the Site Setngs / Gear buton.

 Select Site Contents from the drop down menu.

 Select the NOCAccordion list.

 Select the desired link from the list. The detailed page displays.

 On the View tabs, press the Edit Item buton. 

 Edit the desired felds

 Press the Save buton.

Deleting a Link
 From the NOC Homepages, press the Site Setngs / Gear buton.

 Select Site Contents from the drop down menu.

 Select the NOCAccordion list.

 Press the ellipsis buton (…) next to the desired item and select Delete Item from 

the context menu.
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 Press OK to commit the deleton of the link.
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MerLin Applications

Introduction The following MerLin applicatons and tools have been updated to be accessed from within 
SharePoint 2013. Changes to the functonalites and user interfaces are discussed further in 
this secton

 CommCenter

 Daily Task Checklist

 Facilites Work Request Form

 Learning Management System (LMS)

 Managed Documentaton (DMS)

 ML Employee Handbook Acknowledgement tool

 NOC Escalatons Lookup

 OOce Access Card Request Form

 On Call Calendar

 Passport to Learning

 PCR Tool

 Project Request Tool

 Tech  Support Case Exceptons Tool

Commcenter Merchant Link Commcenter provides a form based template for generatng department or 
company‐wide communicatons. This form helps to ensure a standardized look and format to
oOcial announcements. 

The new interface provides a sortable list of past Commcenter announcements with a search
bar. Results are displayed in a paged format.

Creating a New Message

 Press the Create a new message buton at the upper right of the page. The create 

dialog window appears: 
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 Enter the Subject of the message.

 Select a Type of Notice from the drop down selector.

 Select an Impact level.

 Enter a value for the Date of Impact.

 Check all Impacted Departments from the checkbox list. Notfcatons are sent to 

these recipients.
 A preformated message appears in the editor. Placeholders for message 

mandatory items appear in brackets (i.e. {{NoticeType}}}} ). These placeholders must 
remain in the message unedited. Replace the content area with your message.

 Atach any relevant fles to the message. There is an upper limit of 4mb total. You 

can send any number of atachments as along as the total size remains under this 
limitaton.

 Press SEND at the top of the form when you are ready to send the message. Allow 

the form to complete before closing the dialog window.
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NOC Daily Task
Checklist

Managing the Checklist
Designated NOC team members are added to MerLin’s NCL-Admin user group. (This requires
a MerLin admin member to add this group to the user’s profle in MerLin).

When the user is added to the groups, they will see a new icon on the NOC Checklist page 
ttled Manage Checklist: 

Pressing this buton displays the Manage NOC Checklist Entries dialog. This dialog displays 
all currently actve checklist items ordered by their JobID index number: 
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The Add New buton at the top of the dialog opens a new item to be added to the list. 
Selectng the Edit buton next to an entry displays the form populated with the item’s 
informaton. With new additons you will see an empty version of the form: 

Simply alter the data as desired. The dialog will update the felds when you toggle between 
daily events or monthly events: 
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 Press the Commit buton once your changes are done.

Adding a checklist item
Press the Manage Checklist icon on the NCL homepage. The Manage NOC Checklist Entries 
dialog appears.

 Press the Add icon. The dialog update to show an empty form.

 Complete all felds on the form.

 Press the Commit buton.

Editing a checklist item
 Press the Manage Checklist icon on the NCL homepage. The Manage NOC Checklist

Entries dialog appears.
 Press the Edit icon. The dialog update to show the populated form.

 Alter all desired felds on the form.

 Press the Commit buton.

Deleting a checklist item
 Press the Manage Checklist icon on the NCL homepage. The Manage NOC Checklist

Entries dialog appears.
 Press the Edit icon for the checklist item you wish to delete.

 Change the Status selector from Active to Expired.

 Press the Commit buton.

Points to remember
 Changing the Report Subject feld on an existng checklist item will efect historical 

reportng. Reports pull the ttle from the JobID so if you change the name all past 
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data will use the new entry.

 All felds must be completed. When entering the Day of Month feld on a monthly 

entrys, you must also assign a tme.
 

 All tme is entered in Military format (i.e. 15: 00 for 3: 00 pm)

 
 You will have to put in a MerLin Change Request (MCR) if you need changes to the 

Report Category dropdown selector. 

The Escalation Instruction URL must be populated correctly to work. If you are entering an 
URL to a document on any shared network drive the address must be preceded with files/// 
to work correctly. 

When copying the address from your explorer window you do not need to worry about 
correctng the forward/back slashes. The code will fx that automatcally. (i.e. M: \SSP‐
Public\flename.ext would otherwise need to be changed to fle: ///M: /SSP‐
Public/flename.ext)

Be careful of spaces in the address. For examples, when combining the path with the fle 
name it is common to see that a space is introduced afer the last slash and before the fle 
name. If this occurs the link will not work.
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Facilities Work
Request Form

The Facilites Work Request Form has migrated with almost no change other than in look and
feel. This tool provides the user with the ability to notfy responsible staf members about 
issues within the Merchant Link facilites that need repair or atenton. 

Once the form is flled out an email is generated to the appropriate contacts for resoluton. 
The tool bar buton pictured to the lef is accessible on every MerLin on SharePoint page at 
the top of the page.

Learning
Management

System

Formerly known as Passport to Learnings, the learning management system provides tools to
track staf member’s learning experiences and to facilitate computer based training and 
compliance eforts. There have been a number of changed to this tool to simplify its use by 
both students and instructors.

 To access the LMS portals, select Learning and Development from the Departments 

entry on the main toolbar.
 Click on the LMS Home entry in the Quick Links navigatonal panel at the lef. The 

Learning Management System’s welcome page displays: 
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Searching for and Enrolling in Courses
The Course Explorer provide you with tools to search for informaton on available courses 
that are provided by Merchant Link or an approved Third‐Party vendor. The course listng 
provides tools to search for a courses, to page through a list of coursess, and to view the 
details of a course.

1. To search for a course by names, change the drop down on the search bar to Course 
Name. Enter a search term and press the Filter List buton.

2. To view details on a course press the View buton at the right of the record. The 
Course Details page displays.

 Informaton on the course’s providers, descriptons, objectves and course outline 

appear.
 If an Instructor‐Let course (ILT) had scheduled class sessions availables, they will 

show under the Available Class Dates secton. If the class has seatng available or 
will ofer remote atendances, then an Enroll Me buton displays. Clicking this buton
will add the course and class date to your course profle.

Viewing your Courses
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To view a list of the courses you have completed: 
 Navigate to the LMS homepage from the Learning and Development homepage.

 Click on My Profile under the Quick Links navigaton panel on the lef. Your course 

profle displays: 

Accessing Your Transcript
 Navigate to the LMS homepage from the Learning and Development homepage.

 Click on My Profile under the Quick Links navigaton panel on the lef. 

 Click on My Transcript under the Quick Links navigaton panel on the lef. Your 

transcript with all completed courses displays: 

This view provides you with a paged list of all completed courses. The list can be sorted by 
various column headings as well as fltered with the search bar in the same manner as the 
Course Explorer.

Administrative Functions
For those  staf members with appropriate permission levelss, there appears a set of tools to 
manage the coursess, class instancess, and user profles for the system. Informaton on these 
tasks appear below.

To access the administratve area: 
 Navigate to the LMS Homepage.

 Click on the Administration entry in the Quick Links navigaton panel: 
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 The administraton page opens with the Curriculum view by default: 

Creating a New Curriculum Entry
The Curriculum Manager provides the ability to create groups of course under a single 
curriculum name or header. This allows the curriculum to be assigned to a departments, a 
MerLin group of userss, or to the company as a whole. 

Courses atached to these curriculum records will automatcally display on the appropriate 
users’ course profles. They will not have to be added to a user’s profle or manually enrolled 
in by the user.

To create a new curriculum record: 

 Press the Add New Curriculum buton at the tops, right of the page. The data entry 

dialog displays: 

 Enter a Curriculum Name.

 Select who this curriculum Applies To (i.e. Alls, Departments, User Type.

 Select either the Department or User Type if you selected either of these optons.

 Press the Commit buton to save your entry.

Adding Courses to a Curriculum
To add courses to a new or existng curriculum record: 
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 Browse to the Curriculum Manager. 

 Click on the View buton to the right of the desired curriculum record. The 

curriculum details dialog appears.

1. Press the Add a Course buton at the top of the dialog. 
2. Then Select a Course entry feld appears at the top of the screens,
3. Press the Commit buton to add the course. The course now appears in the list.

Removing a Course from a Curriculum Record
 To remove a courses, press the Remove buton next to the course desired. As 

confrmaton dialog displays.
 Press OK to commit the removal acton.

Managing and Creating Courses
TBD
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Managed
Documentation

SharePoint 2013 contains its own tools to upload and manage documentaton. The 
Traditonal Managed Documentation tools from the original version of MerLin has been 
included as a convenience to allow document owners tme to get familiar with SharePoint’s 
tools and capabilites.

As documentaton is converted over to SharePoint natvelys, this tool will be phased out from 
general use. In the meantmes, updated instructons for using this tool are included here.

 Main Toolbar – Provides a buton to upload a new Document.

 List Filter – Allows the user to flter or search by several felds limitng the records 

being shown.
 Documentation List – Provides a list of documentaton that are sorted by the 

column headers. The list is also paged so you can navigate First/Previous / Next / 
Last views. The page displays 20 records at a tme.

Filtering Documentation
To flter or search for a document: 

 Drop down the select box and choose a feld to search against: 

 ID

 File Name

 Modifed by

 Checked out to

 Owned or Maintained by

 Owning Department

 Category
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 Enter the search keywords or other criteria in the text box provided. Selectng 

certain felds will replace the text box with a dropdown list such as searches for 
names of those who have a document checked outs, the owner of the documents, 
etc.

 Press Filter List to apply the search. The results appear: 

Uploading a NEW document

The following instructons provide details on uploading a NEW document to the Document 
Management System. If a document has already been published to MerLin it should be 
checked out of MerLin for editng and then checked back in to the system. Details on 
accomplishing those tasks appear later in this document.

 Press the Browse buton.

 Find the local fle on your system using the dialog window and press Open.

 Enter the Title of the document.

 Provide a Description for the document.

 Assign a Document Type for the document.

 Assign the Department that owns or maintains the document.

 Assign the Document Owner. (If there isn’t a current owner then the document 

should be assigned to the department head).
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 Choose the Next Review Date.

 Press the Upload buton on the top toolbar to upload the document.

Checking Out a Document for Editing
To check out a document for editng: 

 Select Managed Documentation from the Quick Links secton of the MerLin 

homepage.
 Locate the document by fltering on an available feld or doing a free text search 

against the contents of a fle.
 Once locateds, click on the View buton to the right. The Details dialog displays.: 

1 – Toolbar
Contains actons that can be taken on the document such as Editng certain detailss, 
checking the document out for editngs, or deletng the document. The delete buton
is only available to MerLin administrators or the document owner.

2 - Document Details 
This panel displays various atributes on the document as well as a hyperlink to 
open and view the document.

3 – Archived
This new additon provides a view of all prior versions of the document that have 
been commited to the system. A hyperlink to open the historical copy is provided 
along with other document atributes.

 Press the Check Document Out buton on the toolbar at the top. A File Download 

dialog window displays:  
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Note
The File Download dialog will display for most OOce documents. If the document is 
an Acrobat fle (.pdf)s, it will open in the browser window instead.

If you receive a dialog asking you to provide your username and passwords, simply 
click Cancel or hit the Escape key.

 Select Save from the fle download dialog.

 The document is immediately stamped as checked out.

Checking Documents In
Afer you have made changes to your document you can upload it to MerLin to replace the 
prior version. Do not use the Upload a New Document buton. You must perform the 
following steps to successfully update existng documentaton: 

 Select Managed Documentation from the Quick Links secton of the MerLin 

homepage.
 Locate the document by fltering on an available feld or doing a free text search 

against the contents of a fle.
 Once locateds, click on View buton located at the right of the record: 

 When presseds, the Document Details dialog displays: 
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 Press the Check In buton on the top toolbar. The File Details windows will display 

the upload form: 

 Press the Browse buton to locate your local updated copy.

 Select the Revision Type from the dropdown. This will afect the version number of 

the document:  
1. Default

The Default opton will change the version number in the last two positons
For examples, version 0.0.14.0224 will be updated to 0.0.14.0225

2. Minor
The version number will be updated on the last three positons. For 
example. 0.0.14.0224 becomes 0.1.14.0225

3. Major
The version number will be update on the frst positon and the last two 
positons. For examples, 0.0.14.0224 becomes 1.0.14.0225

 Select the Next Review Date from the calendar feld.

 Press the Upload buton on the top toolbar.

Notess
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Document names must remain the same. If you choose a fle with a diferent name from
the dialog windows, the system will alert you and empty the fle feld. You will be 
required to locate your local copy again using the browse buton.

The existng document will be archived and then overwriten by default. There no 
optons to change this behavior.

Documents uploaded on the same day will overwrite the existng document and will not 
update any archived version so multple revisions on the same day will result in the fle 
refectng the last uploaded version.

Editing Document Attributes
The DMS allows document owners and DMS administrators to change some basic atributes 
stored by the system as well as to change the ownership of the document by a specifc 
individual and/or department.

To edit the document atributess, perform the following steps: 

 Select Managed Documentation from the navigaton panel on the lef.

 Locate the document by fltering on an available feld or doing a free text search 

against the contents of a fle.
 Once locateds, click on the fle name to drop down the menu.

 Select Edit Properties from the dropdown menu. The File Details window displays: 

 Update the Title of the document (note that this is NOT the flename of the 

document).
 Make any needed changes to the Description of the document. Basic editng tools 

are provided.
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 Update the Document Type. This will move the fle from one document type folder 

to another on the MerLin server.
 Update the Department. This will move the fle from one department folder to 

another on the MerLin server.
 Update the Document Owner. This reassigns the document to the selected owner 

who will have edit and delete rights over the fle.
Update the Next Review Date as needed.

Press the Save Changes buton to commit the changes.
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ML Employee
Handbook Tool

The Employee Handbook Acknowledgement Form functons in the same way as it did in the 
custom MerLin portal. New users are presented with a notfcaton and hyperlink to 
download the employee handbook. Once that link is followed the client informaton is 
recorded. Reports are generated by request to the MerLin development group.

NOC
Escalations

Lookup

The Network Operatons Center (NOC) Escalatons Lookup tool provides the ability to search 
for known error messages and their escalatons procedures. This tool has been ported over 
with litle to now changes to its features and functonality as they appeared in the custom 
version of MerLin.

Viewing Entry Details
Afer you have searched for a partcular error messages, you can view the details of a record 
by clicking on the View buton to the right of the record. Details are then displayed in the 
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popup dialog window.

Depanding on your permission levels you may have the ability to edit or delete the record. 
Butons for all actons you may perform are at the top of the dialog window.

Adding a New Record
To add a new escalaton record: 

 Navigate to the NOC Escalations tool using the link on the Quick Links launch panel 

on the lef side of the NOC homepage.
 Click the Add a new record buton at the upper right side of the list. The Add a new 

record dialog displays.
 Make all the needed entries and press the Commit buton to save the new record.

Deleting an Entry
 Navigate to the NOC Escalations tool using the link on the Quick Links launch panel 

on the lef side of the NOC homepage.
 Click the View buton for the record you want to delete. If you have permissions to 

delete recordss, the toolbar will include the Delete buton.
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 Press the Delete buton. A confrmaton dialog bog displays. Press OK to contnue 

with the deleton of the record.
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Agent On Call
Calendar

The Agent On Call Calendar has had a number of changes to the interface. The calendar will 

show with a limited number of agents showing should there be more than can be displayed. 

Hovering over the cell will show a link to expand or collapse the cell: 

Additonallys, a link to Add a new on call item shows when hovering over the cell. Clicking on 

any of the user entries displays a dialog window with all the informaton for the on call 

agent: 

Creating a New On Call Agent Record
 Navigate the calendar to the month desired

 Hover over the date the record will start. A band with the Add hyperlink displays.

 Click on the +Add hyperlink. The Schedule an On Call Escalation Agent displays.
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 Select the Primary Agent from the dropdown.

 Select the Secondary Agent from the dropdown (if applicable).

 Select a Job Function from the dropdown.

 Select a Start Date for the on call record.

 Select a End Date for the on call record.

 Select the Frequency for the record (Dailys, Monthlys, Yearly)

 Enter any additonal Notes for the record.

 Press the Commit buton at the top of the dialog.

Editing a On Call Record
This acton requires proper permissions to perform. If you do not have permissions suOcient 

to make these changess, see your manager to request approval.

 Find the date and agent for a record.

 Click on the Agent name. The On Call Agent Details Dialog window displays.

 Press the Edit buton at the top of the dialog. The dialog enters edit mode.

 When you are done with your changess, press the Commit buton at the top of the 

dialog window.

Deleting an On Call Record
This acton requires proper permissions to perform. If you do not have permissions suOcient 

to make these changess, see your manager to request approval.

 Find the date and agent for a record.

 Click on the Agent name. The On Call Agent Details Dialog window displays.

 Click on the Delete buton. A confrmaton dialog displays.

 Press OK to complete the deleton of the record.
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Responding to an On Call Event
If you are a designated On Call Agent responding to a call for assistances, you can log that 

response and have notfcaton sent for proper compensaton and records keeping purposes. 

Responses can only be logged on the day that they are received. (If logging near midnights, 

please do all you can to enter the event prior to midnight for proper accountng).

 Navigate to today’s date on the calendar.

 Select your name from the calendar. If you are not the on call agent but are 

responding in their places, select that agent / job functon.

 Click on the Respond to Call buton.

 Enter the name of the Call Initiator.

 Enter the tme under Call Received.

 Enter the Response Duration.

 Enter as much detail as possible under the Notes entry.

 Press Commit to complete the form entry.
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Tech Support
Case

Exceptions Tool

The Tech Support Case Exceptons tool is located under a hyperlink on the tech Support 
homepage under the secton enttled “I want to…”

This secton provides informaton on how MerLin on SharePoint supports the recording of 
tme worked on cases that cannot be efectvely accounted for on our phone and other 
monitoring systems. 

The Service Delivery group needed an efectve means of accountng for research or other 
tme spent in supportng cases accountng for productve tme that is not being represented 
in the metrics being reported. Further details on the problem should be addressed to the 
Service Delivery Department.

Exceptions Tool Interface

1. Main Toolbar – Provides butons to Add a New Exception or to View Reports.
2. List Filter – Allows the user to flter by several felds limitng the records shown.
3. Status Actions – Provides a “Select/De‐select All” checkbox and status drop down 

to make bulk changes to the status of listed items. Restrictons apply and are 
discussed later in this document

4. Case Exceptions List – Provides a list of case exceptons from the late 60 dayss, 
sorted by the status in the following order:  Pending Approvals, Actves, all else.

Client Usage 
Staf members are the only ones who can create a case excepton for themselves. 
Additonallys, once created they are the only ones who can stop the “tmer” on a record.  
Other functonality consideratons and limitatons are noted in this guide.

The policies and procedures on when and why a client uses this tool is outside the scope of 
this document. For specifc informaton on these topicss, please consult your manager or the 
Service Delivery manager.

This secton will provide specifc informaton on how Technical Support representatves will 
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enter and manage their specifc excepton entries.

Creating a Case Exception
To create a record: 

 Navigate to the Case Exceptons tool

 Click on the Add a New Exception buton. The Add a New Exception dialog appears.

 Enter a Case Number.

 Select a Reason from the provided drop=down. Optons are: 

o Case Research

o Meetng

o Project

o Other

 Provide the applicable Notes

 Press Start at the top of the dialog. The dialog closes.

Editing or Completing a Case Exception
To edit a current Case Excepton: 

 Navigate to the Case Exceptons tool

 Click on the View buton at the right of the record you want to edit. The dialog 

appears.
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 Press the Delete buton to delete the record completely.

 Press the Edit buton to change details or complete the excepton record. The dialog

enters edit mode

 Change the Case Numbers, Reasons, or append Notes as needed.

 To complete the records, press the Stop Clock buton.

 Select the Save Changes buton to commit your changes. 

If the excepton is being completeds, the record will be marked Pending Approval and an 
email will be sent to your direct report manager and a copy will be sent to you. To see the 
changes updated on the main Case Exceptons pages, you must refresh the view.
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Manager’s Tools 
The Case Exceptons tool provides Managers with various functons to manage and report on
exceptons created by their staf members. Case exceptons can only be approved by the 
direct report manager as defned in MerLin. 

Each employee has a designated Manager on their profle. This must be properly set by the 
MerLin development team when the user’s profle is created. If a user’s report‐to manager 
or department changess, these details must be updated by a member of the MerLin Admin 
team. 

Email notfcatons generated by this tool draw upon the MerLin staf member database. 
Email addresses must but up to date for staf members and their defned managers for 
notfcatons to work properly.

Viewing and Exporting Reports
The Case Exceptons tool allows management and report‐to supervisors to view Approved 
case excepton records for desired date ranges and for alls, or selected staf members. This 
report can be viewed in HTML or exported to an Excel spreadsheet for further work with the 
data.

1. Select one or more entries in the Staff Names feld. 
(To select multple entriess, hold down the Control buton while lef‐clicking on the 
entry. if you have “All Staff Members” selecteds, that will take precedent over any 
other entries you select)
2. Select the start and end range dates to report on APPROVED entries.
3. Choose to either view the HTML version or to Export to Excel.
4. A warning dialog statng that the format is not the same as expected. (html
being sent as an Excel fle) Choose to Open anyway.
5. The report will open in Excel. If it does nots, minimize all windows as a 
dialog may have popped up UNDER the actve windows.

Approving or Denying a Case Exception
Case exceptons can be denied when in any status. An approval cannot be applied to a 
record that does not have a End Date as the record is stll in actve status.
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 Navigate to the Case Exceptons tool

 Click on the View buton at the right of the record you want to edit. The dialog 

appears.
 Change the Case Numbers, Reasons, or append Notes as needed.

 Change the Status drop down.

 Change or adjust the Start Date /Time or End Date / Time as needed. The End Date 

feld are only available on completed exceptons when the clock is stopped by the 
staf member.

 Press the Save buton. Close the dialog and refresh the main Case Exceptons page 

to see the updated list.

Bulk Status Changes
To make a change to the status of seveal case exceptons: 

 Check the Select All check boxs, or multple check boxes from the list

 Drop down the Status drop down selector.

 Press Change Status to commit the change.

 As long as the persons is the client’s manager/report to then the record will be 

updated

Notes
The status of an excepton can only be changed through the bulk tools if: 

1. The manager of the record/staf matches the user making the change.
2. The case excepton has both a start and end date.
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